
Getting Started...

When you start FontLister, you'll see the main screen with a listview-window (located to the left) with 
all your fonts, and a text-window (located to the right). By clicking on one of the fonts in the fontlist-
window, you'll notice that the text in text-window immediately changes its font to the selected one. 
Click somewhere in the text-window and you can write your own text. You can also import text from 
file or copy text from another program using standard windows Ctrl+C and Ctrl+V shortcuts).

Try selecting several fonts from the list by holding down Ctrl or Shift while left-clicking in the list. Now 
change the view-mode by clicking on the  (Compare Mode) button located in the top toolbar. You 
will get a list of all selected fonts. From this list, you can unselect some of them by right-clicking the 
font and choose Unselect font from the context popup-menu. Again, you can use Ctrl/Shift to select 
multiple items.



List of Fonts

This window shows the list of your fonts. Click on a font to view it in Edit or Compare Mode windows to
the right. If you select multiple fonts, the Compare window will show them all, but the Edit window will
only show currently focused font.

To select multiple fonts, press and hold Control (Ctrl) key while clicking on fontnames. You're able to 
select a range of fonts by clicking first font in set and then press & hold Shift while clicking on last font
in range.

Right-click in this window to bring up the popup-menu shown above. Click on an item to read about its
function.



Open Windows Sample

Opens Windows Sample Window with currently focused font.



Install Font

Installs selected fonts on your Windows system (copying selected fonts into Windows system subfolder 'Fonts') and
adds them to Windows Font Table. This option is only available in Fonts in a Folder View.



Delete Font Ctrl+D

Deletes fonts from Fonts Folder and removes them from Windows Font Table. This option is only available in 
Installed Fonts View.



Select All Ctrl+A

Selects all fonts in list.



Invert Selection

Inverts current selection of fonts. This is especially useful if you have selected all fonts in the list and while you 
were browsing them you unselected the one you did not like. Now you are able to invert the selection and delete 
them if that is what you want.



Print

Prints selected fonts without prompting you first using settings selected in the Print Window (Ctrl+P). It is 
especially useful if you want to make a quick print of some fonts without going through the Print Window dialog 
each time.



Font Properties

Shows Font Properties Window for selected font.



Edit Mode Window

The Edit Mode enables you to type in your own sample text. It works like the Windows Notepad 
application, i.e. you're able to cut, copy, paste, undo, etc. using the same shortcuts or menuitems. It's
only possible to view one font at the time when using this mode; if you want to view multiple fonts 
use Compare Mode.

Notice: The first line will be used as Sample Text in Compare Mode.

List of useful shortcuts

Undo Ctrl+Z

Cut Ctrl+X
Copy Ctrl+C
Paste Ctrl+V

Select All Ctrl+A



Compare Mode Window

You are using this mode to compare multiple fonts. Select fonts you want to compare from the List of 
Fonts and this window will automatically be updated (and sorted alphabetically) with the selected 
fonts.

You're able to unselect fonts directly from this list by right-clicking its sample and selecting Unselect 
font(s). If you want to unselect multiple fonts at once, click them holding down Control (Ctrl) or select 
a range by clicking the first, press and hold Shift and then press last.



Windows Sample Window

If you have FONTVIEW.EXE installed on your computer and you're in either Fonts in a Folder View or 
Installed Fonts View, you are able to view the standard Windows Sample for a selected font. Select a 
font from the List of Fonts and click View->Windows Sample. The FONTVIEW.EXE application will open 
with the selected font.



Screen Fonts View

This view will list all Screen fonts supported by your Windows system (normally all available). When 
using Screen Fonts View you are limited in a number of ways, e.g. you are not allowed to delete fonts,
view extended information about a fonts NameTable, etc. because FontLister only reads the fonts from
memory and not from a physical fontfile. That is why Screen Fonts View is much faster in loading your
fonts than e.g. Installed Fonts View. If you want to be able to delete fonts, you will have to use 
Installed Fonts View.



Printer Fonts View

Printer fonts View shows all fonts supported by your selected printer (this is normally all fonts because
Windows GUI simulates TrueType fonts like graphics). This View was only meant to be an alternative to
the Screen Fonts View which you will normally use for finding your fonts. You are not able to delete 
fonts from this View; use instead the Installed Fonts View.



Fonts in a Folder View

Fonts in a Folder View enables you to view fonts from a CD-ROM or from a specific directory on your 
harddrive (not installed on system).

When you choose this view (either from the menu or the toolbar) the current Mode (Edit/Compare) 
will be switched with an Explorer interface as shown below. If you want to search for fonts on your c:\ 
harddrive expand Desktop -> My Computer -> HDNAME (C:). FontLister will automatically read any 
fonts it encounters if you have checked 'AutoRetrieve Font Names'.

It might be you want to search your entire C: drive for fonts. To do this, select the root of your C: 
drive and make sure you have 'Search Sub Folders' set. If FontLister doesn't search your harddrive for 
fonts, click the Refresh button to initiate the search.

The result of the search is shown in the List of Fonts to the left. If the list is empty, no fonts where 
found in the specified directory/directories.

Use the Favourite Folders button if you want to add the current folder to your Favourites List. This 
makes it easy for you to access commonly used Fonts Folders.

Click here for the meaning of legends used in List of Fonts.



Installed Fonts View

This view lists all your installed fonts, i.e. all fonts located in your system Fonts Folder. This is normally
the C:\WINDOWS\FONTS directory. When you are using Installed Fonts View, you are able to do 
certain things not available in Screen/Printer Fonts View, e.g. delete fonts, view Windows Samples, 
retrieving extended information about a fonts name, etc.

To delete a font from your system, select it from the List of Fonts and use the Edit 4 Delete Font 
menu-item.



Print Methods

That are the available print methods illustrated with pictures. When you click on one of them, some information about 
the method will be shown in frame Range below.



All Fonts

When All fonts is selected, all available fonts from fontlist-window will be printed.



Selected Fonts

If Selected fonts is checked, only selected fonts from the font listview will be printed.



Print Method Description

This is some information about the above selected print method. Select method by clicking on one of the above 
layouts.



About FontLister

FontLister is a most comprehensive utility for managing True Type, Adobe Type 1 and Raster fonts on Windows 
95/98 machines today.

Features:
8        easy installing/deinstalling fonts on Windows system
8        very detailed informations about fonts
8        best catalogization and printing fonts

 You can get context help on almost any control. If there's a    (question button) in the upper-right corner of dialog, 
click it, then click on control and you'll get the short description about that control. If there's no question button, press 
F1 button while the control is active (has focus).



Print Range

If you only want to print the fonts you have selected in the fonts listview, check the Selected fonts item or if you want 
to print all available fonts, then check the All fonts item.



Legends of Views

When browsing the different Views you might encounter some different legends to the left of the fontname. Below 
is a list of all used legends and a short description of its meaning.

Indicates a TrueType (*.ttf) font.

Indicates a TrueType (*.ttf) font already installed on your system. This icon only makes sence, if you are viewing 
Fonts in a Folder (uninstalled fonts).

Indicates a Raster font.

Indicates an Adobe Type 1 Font.

Frequently Asked Questions (FAQ)

For latest release of the FontLister FAQ make sure to check the online FAQ page at:

    http://www.theill.com/fl/faq.htm

How do I change the fontsample-text, used in compare-mode?

The compare-mode uses the first line in the text-window in edit-mode. Change to edit-mode
and write the wanted sample, then change back to edit-mode.

I'm having trouble removing some of my fonts, what's wrong?

If you want to delete some of your installed fonts, I suggest you select the "Installed fonts"-
option in the View-menu. This loads all your fonts, including all the different font-styles. Ex.
the Arial font will be several fonts, like "Arial Bold", "Arial Italic" and "Arial Underline". When
viewing your fonts with the "Screen fonts"-option the Arial fonts only shows *one* 
occurance - "Arial".

Why can't I print or view the Windows 95 fontsample?

To use the default Windows 95 fontsample, you need to know the filename of the font you 
want to view. If you're viewing "Screen fonts" or "Printer fonts" and selects the "Arial" font, 
FontLister doesn't know which of the "Arial"-fonts to use (Bold, Italic, Underline, ect.). 
Therefore, you have to view your fonts with the "Installed fonts"- or the "Fonts in a Folder"-
option.

How do I install some fonts? 

Simple. Just select the "Fonts in a Folder"-item in the View-menu. Now browse to the 
directory with the fonts. Click on OK when you see the facename and filename of the fonts 
you want to install. All the fonts are shown in the fontlist to the left in the window. Select 
the fonts you want to use and go up in the Edit-menu and select "Install font" or "Install 
fonts" depending on how many fonts you would like to install.

How do I delete some fonts? 



Be sure to read the "I'm having trouble removing some of my fonts, what's wrong?" 
question first! Select the fonts you want to remove from you system from the fontlist to the 
left. Go to the Edit-menu and select "Delete font" or "Delete fonts", depending on how many
fonts you would like to delete. Notice: All fonts are placed in the Recycle Bin if you regret 
the removal.

Why doesn't the "Refresh"-button refresh my fonts? 

The "Refresh"-button is used to refresh the windows. If you would like to reload (refresh) 
the fontlist, go to the View-menu and click the checked mode (Screen, Printer, Fonts In 
Folder or Installed).

I don't like the standard header and footer on my prints! 

If you would like to change them, go to the File-menu and select the "Paper Setup..."-item. 
In this window, you can customize your header and footer. Ex. you can change the 
headerfont, tell FontLister to insert current time and/or date and the pagenumber.

The gap between the fontname and the sample is way to small/big! 

Go into the Paper Setup (File -> Paper Setup...) and change the value of the splitterline. 
You'll see three values, the first is the actual line, the second is the minimum value for the 
line and the third is the maximum.

Is it possible to change the margins of my prints? 

Yes! Go into the Page Setup (File -> Page Setup...) and change the values for the left, top, 
right and bottom margins.

I don't want to be asked if I would delete a font; can I change that? 

Yes! Select the Options-menu and uncheck the "Confirm Font-delete"-item.

My computer seems to lock up when I'm using FontLister. Why's that? 

It's probably because you have some bad fonts installed. Try to remove all fonts from 
"Bayer Corporation an AGFA Division". To do that, click "Start" button, then "Find -> Files or
Folders". In the first window, browse to your Fonts directory (e.g. C:\WINDOWS\FONTS) as 
the one to search in, then type in "Bayer Corporation" (without the quotes) where it says 
"Containing text", and it will look for that string of text inside all your font files! When you 
get a bunch of fonts listed as a result, you can get rid of them right by just highlighting and 
deleting them. If Windows tells you they can't be deleted, right-click on the name and 
choose "Properties". Remove any checkmarks in any of the boxes marked "Read only" and 
"Archive" and such. Click OK and try deleting the file again.
When you have removed all these fonts, reboot your system and everything should be 
working again. Bad fonts are typically included with HP Printers (HP Font Disks).

Some of the images on the toolbar and in the menus are missing. 

Older versions of the COMCTL32.DLL file (located in your \WINDOWS Folder) are not able to



show images correctly. Download newest version from the Microsoft Site to correct this. Just
click here to get the install file (it's around 600 kb).

Why doesn't the memobox in Edit Mode save modified text for future sessions? 

You'll have to use the Import text option. Go File->Import Text (or press Ctrl+M on your 
keyboard) and select a textfile you want to use as your sample text. FontLister will ask you, 
if you want to use this text as your default text. If you confirm, FontLister will always try to 
load and use this file at startup.



List of Fonts

Click a font to view a sample of it in the Edit Window or Compare Window (located to the right). You are able to 

view multiple fonts by changing to Compare Mode. Click  to change Mode. Try to right-click in this list. A menu 
will popup with which allows you to access common functions.

Read more...



Refresh

Tries to search selected Folder for fonts. Use Refresh if you have changed 'Search Sub Folders' and want to start 
your search from current Folder.



Search Sub Folders

Search for fonts in all sub Folders starting from current one. Especially useful if you want to search entire drives.



AutoRetrieve Font Names

Reads names automatically when found. Especially useful if you want to browse single Folders with few fonts.



Favourite Folders

Use this button if you want to add the current folder to your Favourites List. This makes it easy for you to access 
commonly used Fonts Folders.



Folder Path

The currently selected Folder. If it reads Not a valid Folder you are unable to start a search from here.



Fonts in a Folder Shell Tree

Select a Folder with fonts from this Explorer like tree. Expand nodes by clicking the plus (+) to the left of its name 
and close nodes by clicking the minus (-). Right-click nodes to bring up a standard shell context popupmenu.



File Menu

Import Text... Ctrl+M
This option is enabled only if you are using Edit Mode. It    loads text from a text file into the Edit Mode
Window. After importing text FontLister ask if you want this text to be default text.

Export Sample As Bitmap...
This option exports your text sample in Windows bitmap (*.BMP) image file. This option is especially 
useful for creating various text captions in HTML pages.

Page Setup...
This option calls standard Windows Page Setup dialog for changing size, source, orientation and 
margins of working page.

Printer Setup...
This option calls standard Windows Print Setup dialog for choosing printer and adjusting its properties.

Print Preview
Previewing the outgoing page.

Print... Ctrl+P
Change options for printing, e.g. header/footers, method, etc.

Exit
Exiting FontLister.



Edit Menu

Undo Ctrl+Z
Undo last action performed in Edit Mode Window.

Cut Ctrl+X
Cuts selected text from Edit Mode Window into ClipBoard.

Copy Ctrl+C
Copies selected text from Edit Mode Window into ClipBoard.

Paste Ctrl+V
Paste text from ClipBoard into Edit Mode Window.

Select All Ctrl+A
Selects all text in Edit Mode Window or all fonts in List of Fonts depeding on the focus.

Mark all Fonts
Checks all fonts in List of Fonts.

Unmark all Fonts
Unchecks all fonts in List of Fonts.

Install Font
Installs selected fonts on Windows system (copying selected fonts into Windows system subfolder 
'Fonts') and adds them to Windows Font Table. This option is only available in Fonts in a Folder View.

Delete Font Ctrl+D
Deletes fonts from Fonts Folder and removes them from Windows Font Table. This option is only 
available in Installed Fonts View.

Copy Font
Copies selected/active font to clipboard.

Tip: Every time you try deleting fonts, FontLister will ask you for confirmation but if you know what 
you're doing you can, from the Settings Dialog (Option menu), deselect Confirm Font Delete and 
FontLister will not annoy you any more with deleting confirmations.



View Menu

Screen Fonts
Switch to Screen Fonts View.

Printer Fonts
Switch to Printer Fonts View.

Fonts in a Folder...
Switch to Fonts in a Folder View.

Installed Fonts
Switch to Installed Fonts View.

Mode 8 Edit
Switch into Edit Mode.

Mode 8 Compare
Switch into Compare Mode.

ANSI-table
Show ANSI-table Window for selected font.

Font Properties F4
Show Font Properties Window for selected font.

Windows Sample
Open standard Windows Sample with selected font.

Toolbars 8 Operation Toolbar
Show/Hide Operation Toolbar

Toolbars 8 Text Toolbar
Show/Hide Text Toolbar

FontList
Show/Hide List of Fonts.

Status Bar
Show/Hide Status Bar

Refresh F5
Refresh all controls.



Options Menu

Styles 8 Bold Ctrl+B
Use Bold fontstyle.

Styles 8 Italic Ctrl+I
Use Italic fontstyle.

Styles 8 Underline Ctrl+U
Use Underline fontstyle.

Text 8 Clear All
Clear all text in Edit Mode Window.

Text 8 Default Text
Clear all text in Edit Mode Window and insert default text, e.g. three lines with all letters in the 
alphabet (uppercase and lowercase), numbers and symbols.

Text 8 ANSI Characters
Generate all 255 ANSI Characters and insert in Edit Mode Window.

Use standard-text
Uses standard text, i.e. one line with uppercase letters, one line with lowercase letters and one line 
with numbers and symbols.

WordWrap
Wrap lines if they can't fit in Edit Mode Window.

Settings...
Opens Settings Window.



Tools Menu

Open Fonts Folder
Opens up Windows Fonts Folder containing all installed fonts.

Character Map
Opens Windows Character Map with selected font.



Help Menu

Contents
Opens the Contents page of this helpfile.

How to Use Help
Calls standard Windows guide "How to Use Help".

About FontLister...
Opens a dialog with information about FontLister, i.e. version, release date, install date, registration 
info, etc.



Settings Window

In this dialog you are able to change various settings. The window has been split in two sections:

General
    Handles general options of FontLister

Layout
    Handles options regarding visual layout of FontLister.

WMF/EMF Export
    Options for exporting characters to WMF or EMF format.



OK

Close dialog and save any changes made.



Cancel

Close dialog and cancel any changes made.



Apply

Apply changes made without closing dialog.



Settings Window: General

Click on the image below to get more information about the different options.



Confirm Font Delete

You will be asked to confirm every font delete. If you are going to delete a lot of fonts you might consider 
unchecking this box before doing so.



Install Fonts in Fonts Folder

Copies all installed fonts into your Windows Fonts Folder (default location is C:\WINDOWS\FONTS). When this box 
is unchecked, installed fonts will only be installed virtually, i.e. no copy necessary. It's not recommended to 
uncheck this box if you're installing fonts from a CD-ROM because the fonts will become unavailable if you remove 
the CD-ROM from your drive.



Settings Window: Layout

Click on the image below to get more information about the different options.



Fonts combobox

Selects which font to use as default font in List of Fonts. It should only be necessary to change this if you're having
troubles reading certain fonts.



Text Color

Selects color to use as global textcolor in FontLister. If you don't want to use any predefined Windows colors, click 
'others' and define your own color.



Window Color

Selects color to use as global window color (background color) in FontLister. If you don't want to use any 
predefined Windows colors, click 'others' and define your own color.



Show SplashScreen at startup

FontLister will as default show an image while loading. You are able to disable the 'splashscreen' by unchecking this
checkbox.



Large Toolbar Buttons

Uses large (32x40) buttons in toolbars. The buttons will furthermore show the buttons function as a text string 
below the images.



Sample

Line of text for use in exported bitmap.



Size

Fontsize of exported fonts. Open combobox to select one of the default fontsizes, or type in your own.



Include Font Name

Paints name of font on bitmap just above actual fontsample.



Include File Name

Paints filename of font on bitmap just above actual fontsample.



Foreground Color

Color of text to use in generated bitmap(s).



Background Color

Color of background to use in generated bitmap(s).



Export to fonts Face Name

Uses fonts face name when generating filenames for bitmaps. E.g. Arial Bold would generate a file called 'Arial 
Bold.bmp'.



Export to fonts File Name

Uses fonts filename when generating filenames for bitmaps. E.g. Arial Bold would probably generate a file called 
'arialb.bmp'.



Export

Starts generating bitmaps using selected settings.



Close

Closes the Export To Bitmap dialog without exporting any bitmaps.



Print Preview Window

You are able to get a preview of the fonts before printing them to your printer, by selecting Print 
Preview from the File menu.

Click on image to read a description of each item.



Print

Print shown preview.



Page Setup

Open Windows Page Setup Dialog.



100% Zoom

Show preview using real size.



Fit to width

Show preview with a full page width.



Fit to page

Show preview of full page.



Zoom

Select a predefined percent from this combo or type in your own.



Previous page

Move to previous page in set (if available).



Current/Go to page

Type in a page to jump to. Especially useful if your preview contains many pages.



Next page

Move to next page in set (if available).



Close

Close Print Preview.



Preview area

This area shows a preview of all selected fonts.



Statusbar

Shows information about current preview, e.g. number of pages.



Print Window

You are able to change the layout of your prints (e.g. header/footer/size) in this window. The Window 
is split in three part:

Layout
    Select Method and number of fonts to print.

Name and Sample
    Select fontname and fontsizes.

Header and Footer
    Select Header & Footer.



Print

Print using selected options.



Preview

Open Print Preview Window.



OK

Close dialog and save any changes made.



Cancel

Close dialog and discard any changes made.



Print Window: Layout

Click on the image below to get a description of the options.



Method

The available print methods illustrated with pictures. When you click on one of them, some information about the 
method will be shown in the frame below.



Range

If Selected fonts is checked, only selected fonts from List of Fonts will be printed. If All fonts is checked, all fonts 
will be printed regardless of how many fonts' selected.



Page Setup

Opens Page Setup Dialog where you can change i.e. margins of page.



Print Setup

Opens Printer Setup Dialog where you can change default printed, DPI, orientation, print quality etc.



Print Window: Name and Sample

Click on the image below to get a description of the options.



Name fontname

Choose which font to use when printing name label of font. This box shows the fontname rendered using the font 
itself. This makes it easier to pick a readable font.



Name fontsize

Choose which size to use when printing the fontname itself.



Sample fontsize

Choose which size to use when printing sample of a font.



Print Window: Header and Footer

Click on the image below to get a description of the options.



Selected Header Font

Currently selected header font. If you want to change this font, click Header Font button.



Header Font button

Select which font to use in the header.



Header Left

The text or field in this box, will be printed in the upper left corner on every page.



Header Center

The text or field in this box, will be printed in the upper center on every page.



Header Right

The text or field in this box, will be printed in the upper right corner on every page.



Selected Footer Font

Currently selected footer font. If you want to change this font, click Footer Font button.



Footer Font button

Select which font to use in the footer.



Footer Left

The text or field in this box, will be printed in the lower left corner on every page.



Footer Center

The text or field in this box, will be printed in the lower center on every page.



Footer Right

The text or field in this box, will be printed in the lower right corner on every page.



Page Field

Inserts auto-page number field in selected region of header or footer. Auto-page number field automatically shows 
current page number on printed page.



Date Field

Inserts auto-date field in selected region of header or footer. Auto-date field automatically shows current date on 
printed page.



Time Field

Inserts auto-time field in selected region of header or footer. Auto-date field automatically shows current time on 
printed page.



Font Properties Window

The Font Properties Windows shows extended information about fonts.

There's three different tabs in the Font Properties window (General, Details and Names), but
only the first two (General and Details) are available when using Screen Fonts View or 
Printer Fonts View since it's not possible to read Name-information from these fonts.



Font Properties - General

Click on image below to get specific information.

The General tab contains information you mostly would like to know about a font. This is: Full Name, 
Font Family, Filename, Folder, Size, Pitch, Family, Font Type, Scripts, Styles and if the font's installed.



Font Sample

Rendered sample of font.



Full Name

This is usually a concatenation of the Font Family and the style, e.g. Arial with a style of Bold Italic would typically 
have Arial Bold Italic as it's full name.



Font Family

The Font Family shows which family the font belongs to, e.g. Arial Bold, Arial Bold Italic and Arial Italic would all 
belong to the Arial Font Family.



File Name

This is the filename of the physical font.



Folder

This is the path to the physical font.



File Size

This is the size (in kilobyte) of the physical font.



Pitch

A font can either be a fixed pitch (or monospaced) or variable pitch (proportional). A fixed pitch font use the same 
amount of space for every characters, ie. the width of the letter "i" is equal the the width of the letter "w". A 
typewriter font are usually using this pitch. In a variable pitch font every characters has it's own breadth, thus the 
distance between two letters is various. Most text in books and newspapers are written using a variable pitch font 
(e.g. Arial, Times New Roman and Tahoma).



Family

Font families describe the look of a font in a general way. The values for families are as follows: 

Decorative Novelty fonts. Old English is an example.
Don't Care Don't care or don't know.
Modern Fonts with constant stroke width (monospace), with or without serifs. Monospace fonts are usually 

modern. Pica, Elite, and CourierNew® are examples.
Roman Fonts with variable stroke width (proportional) and with serifs. MS® Serif is an example.
Script Fonts designed to look like handwriting. Script and Cursive are examples.
Swiss Fonts with variable stroke width (proportional) and without serifs. MS® Sans Serif is an example.

Font Type

Specifies the type of the font. The values for font types are as follows:

TrueType Indicates a TrueType font (e.g. 'Arial' and 'Times New Roman')
Raster Indicates a Raster font (e.g. 'Courier' and 'System)
Vector Indicates a Vector font (e.g. 'Myriad Roman' and 'Lithos')

Scripts

Specifies the supported scripts of the font. For example, "Cyrillic".



Styles

Specifies the styles of the font. For example, "Bold Italic".



Installed checkbox

This combobox is checked if the font is installed (available for use) on the system.



Font Properties - Details

Click on image below to get specific information.

The Details tab contains more detailed information about the font, e.g. height, ascent, descent, 
weight, etc.



Font Properties Details Tab: Attribute List

Height
Specifies the height (ascent + descent) of characters. 

Ascent
Specifies the ascent (units above the base line) of characters. 

Descent
Specifies the descent (units below the base line) of characters. 

Internal Leading
Specifies the amount of leading (space) inside the bounds set by the tmHeight member. Accent 
marks and other diacritical characters may occur in this area. The designer may set this member to 
zero. 

External Leading
Specifies the amount of extra leading (space) that the application adds between rows. Since this 
area is outside the font, it contains no marks and is not altered by text output calls in either OPAQUE
or TRANSPARENT mode. The designer may set this member to zero. 

Average Char Width
Specifies the average width of characters in the font (generally defined as the width of the letter x). 
This value does not include overhang required for bold or italic characters. 

Max. Char Width
Specifies the width of the widest character in the font. 

Weight
Specifies the weight of the font. 

Overhang
Specifies the extra width per string that may be added to some synthesized fonts. When synthesizing
some attributes, such as bold or italic, graphics device interface (GDI) or a device may have to add 
width to a string on both a per-character and per-string basis. For example, GDI makes a string bold 
by expanding the spacing of each character and overstriking by an offset value; it italicizes a font by 
shearing the string. In either case, there is an overhang past the basic string. For bold strings, the 
overhang is the distance by which the overstrike is offset. For italic strings, the overhang is the 
amount the top of the font is sheared past the bottom of the font. 

Horizontal Aspect (Digitized Aspect X)
Specifies the horizontal aspect of the device for which the font was designed. 

Vertical Aspect (Digitized Aspect Y)
Specifies the vertical aspect of the device for which the font was designed. The ratio of the 
tmDigitizedAspectX and tmDigitizedAspectY members is the aspect ratio of the device for which the 
font was designed. 

First Character
Specifies the value of the first character defined in the font. 

Last Character
Specifies the value of the last character defined in the font. 

Default Character
Specifies the value of the character to be substituted for characters that are not in the font. 

Break Character



Specifies the value of the character to be used to define word breaks for text justification. 

Size EM
Specifies the size of the em square for the font. This value is in "notional units" (that is, the units for 
which the font was designed). 

CellHeight
Specifies the height, in notional units, of the font. This value should be compared with the value of 
the ntmSizeEM member. 

Avg. Width
Specifies the average width of characters in the font, in notional units. This value should be 
compared with the value of the ntmSizeEM member.



Font Illustration

This bitmap illustations some of the font attributes.



Font Properties - Names

Click on image below to get specific information.

The Names tab contains information about the font and it's names, e.g. Font Family and copyright 
notice. These information are read from the physical font file and is thus only available when current 
View is Fonts in a Folder or Installed Fonts.



Font Name

Displays the name of the font, including specific attributes, such as italic or bold.



Font Family Name

Displays the name of the font family to which this font belongs.



Version

Displays the version number of the font.



Copyright

Displays the font's copyright information as included by the font manufacturer. Do not assume that missing 
copyright information indicates a public domain font, as it is not uncommon for hackers and font-pirates to remove 
the copyright information contained in commercial fonts.



Trademark

Displays the font's trademark information set by the font manufacturer.



OK

Closes Font Properties dialog and saves any changes made.



Cancel

Closes Font Properties Window and cancel any changes made.



Help

Opens FontLister Help for more help about the different items.



ANSI-Table Window

This Window shows all 255 characters of the selected font.



Auto Update

FontLister will automatically update ANSI-table when you pick another font.



Stay On Top

ANSI-Table will stay on top of all other open windows.



Character Table

The ANSI-table (characters from 0-255) for selected font. Right-click to bring up a popup-menu.



Font Size

Selects size for characters in table.



Table Modes

View horizontal table (32 x 8 characters)

View vertical table (16 x 16 characters)

View table with large fields (enables larger font sizes)



Preview Character

Shows currenly selected character in table.



Controls

Close ANSI-Table Window.



How do I register?

It's quite easy to register your own copy of FontLister; and it's only $5 (more will naturally be 
accepted ;). Visit the FontLister homepage (see URL below) and select 'order copy' from the left menu 
or visit the order-page directly by using this URL:

    https://www.regnow.com/softsell/nph-softsell.cgi?item=1389-1

You'll be transferred to a secure server using the latest secure server technology (SSL and RSA), and 
can ensure secure transactions with users of Netscape, Internet Explorer, and other browsers 
supporting this technology. It's possible to pay using all major credit cards (VISA, MasterCard, etc).

If you still don't feel safe to pay using your credit card, you can mail me the money. You have to send 
me the money in cash, since it would cost me too much to exchange a cheque. Also, you're welcome 
to send me an equal amount of money in your own currency, if you don't have any american dollars. 
Please be sure to include your name and your email address in your letter, otherwise I'm not able to 
send you the needed registration files.

Mailing address:
    ConquerWare
    Attn: Peter Theill
    Kalundborgvej 173
    4300 Holbaek
    Denmark

FontLister page on the Internet:
    http://www.theill.com/fl/

My email Address:
    peter@theill.com




